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SOFTWARE OBJECTIVES:  In Chapter 1, you will use the software to:

1.
Start Peachtree Complete Accounting 2005 (PCA).

2.
Explore the sample company, Bellwether Garden Supply.

3.
Back up Bellwether Garden Supply data.
4.
Restore data with Peachtree’s restore Wizard.

5.
Operate Peachtree’s menus, drop-down lists, lookup fields, toolbar, and navigation aid.

6.
Navigate Windows Explorer.

7.
Explore Peachtree Today to link to the Internet and learn about software features.

8.
Make three backups: 1) Back up starting data for Bellwether Garden Supply; 2) back up Chapter 1 data; and 3) back up Exercise 

1-2.
 

WEB OBJECTIVES:  In Chapter 1, you will do these Internet XE "Internet"  activities:

1. Use PCA to link to Peachtree’s website at www.peachtree.com.
2. Link to Peachtree Software’s Press page.
3. Select two Peachtree News articles and write an essay about each one. 

4. Use your Internet XE "Internet"  browser to go to the book’s website at www.mhhe.com/yacht2005.

5. Complete the first web exercise in Part 1.

Peachtree Complete Accounting 2005 (PCA) is similar to other programs that use Windows. If you have used other Windows programs, you will see the similarities in the menus and windows, entering and saving data, 
and selecting icons. If you are not familiar with Windows, using PCA will help you become familiar with the Windows operating system.

MOUSE AND KEYBOARD BASICS XE "MOUSE AND KEYBOARD BASICS" 
One of the first decisions you need to make is whether you want to use your mouse or keyboard. The instructions in this book assume that you are using a mouse. When the word click is used in the instructions, it means to use your mouse, but you can also use the keyboard.  The instructions below explain how to use your mouse or keyboard.

Using the Mouse XE "Using the Mouse" 
· To single click: position the mouse cursor over your selection and click the left mouse button once.
· To double-click: position the mouse cursor over your selection and click the left mouse button twice, quickly.
· Use the right mouse button the same way you use the left mouse button.
Using the Keyboard XE "Using the Keyboard" 
· If there is an underlined letter in the menu or option you want to select, hold down the <Alt>
 key and the underlined letter to make the selection.
· If you have already held down the <Alt> key and the underlined letter and more selections appear with underlined letters, just type the underlined letter to select the item.

Using Shortcut Keys XE "Using Shortcut Keys" 
Shortcut keys XE "Shortcut keys"  enable you to perform common operations by using two or more keys together.   The tables on the next page show the shortcut keys.
	<Ctrl> + <Letter> Shortcuts

	<Ctrl> + <X>
	Cut

	<Ctrl> + <C>
	Copy

	<Ctrl> + <V>
	Paste

	<Ctrl> + <E>
	Erase

	<Ctrl> + <N>
	New Company

	<Ctrl> + <O>
	Open Company

	<Ctrl> + <B>
	Back Up Company

	<Ctrl> + <R>
	Restore Company

	<Ctrl> + <P>
	Print purchase orders, quotes, invoices, payments or reports

	<Ctrl> + <F>
	Find 

	<Ctrl> + <D>
	Find Next

	Function Key Shortcuts

	<F1>
	Displays the online Help

	<Ctrl> + <F4>
	Closes the current window

	<Alt> + <F4>
	Closes the application window

	<Ctrl> + <F6>
	Moves to the next window

	<Shift> + <Ctrl> + <F6>
	Moves to the previous window

	<F10>
	Toggles the menu bar

	<F5>
	Saves the current record in maintenance windows


PCA'S STARTUP WINDOW
Peachtree's startup window gives you a number of options. 

[image: image73.wmf]
From the startup window, you can Open an existing company, Create a new company, Explore a sample company, Take a guided tour of Peachtree, Convert from a QuickBooks® or One-Write® Plus company, or Exit Peachtree.
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Notice that there is an X in a box ([image: image1.bmp]) on the upper right-hand side of the  Peachtree Accounting - Start window.  
[image: image2.png]Peachtree Accounting - Start.




If you click on the [image: image3.bmp] on the Peachtree Accounting title bar with your left mouse button, the window closes and your screen displays the File, Options, Help menu bar 
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	Comment
The illustrations in this text were done with Windows XP and Peachtree Complete Accounting 2005, Educational Version.


THE WINDOWS ENVIRONMENT XE "THE WINDOWS ENVIRONMENT" 
One of the benefits of Windows is that it standardizes terms and operations used in software programs. Once you learn how to move around in PCA’s menus, you will also know how to use other Windows applications.  

To learn more about the Windows environment, let's look at a PCA window. The window illustration on the next page shows the parts of a PCA window as well as the menu bar for Bellwether Garden Supply.  In Windows 98, notice that each word on the menu bar has an underlined letter. (If you are using Windows XP, menu bar selections do not show underlined letters.)  If your menu bar selections have underlined letters that means you can make a selection by typing <Alt> and the underlined letter or by clicking on your selection with the mouse.  Each time you make a menu bar selection, another menu appears. 
For now, let's study the parts of the window shown below. Some features are common to all software programs that are written for Windows. For example, in the upper right corner is the Minimize [image: image4.bmp] button, Double Window [image: image5.bmp] button, and the Close [image: image6.bmp] button. The title bar, window border, and mouse pointer are also common to Windows programs.  Other features are specific to PCA: menu bar, toolbar, and navigation aid.

Windows programs all use menus in the form of horizontal menu bars and drop-down menus.  The contents of these menus will differ depending on the application you are using.  PCA's menu bar and drop-down menus are specific to the features needed for general ledger accounting.
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(
Peach icon: Click on the Peach icon and a menu appears with options such as:  Move, Size, Minimize, Maximize, Close, Next. 
· Title Bar XE "Title Bar"   The bar at the top of your screen. When a company is open in PCA, the name of the company is displayed on the Title Bar. If your window is minimized, you can put your mouse on the Title Bar, click and hold the left mouse button and drag the window around the desktop XE "desktop" . The title bar shows Peachtree Accounting: Bellwether Garden Supply.
(
Menu Bar: In PCA 2005, Educational Version, there are nine menu bar selections. If your menu bar selections have underlined letters, that means you can make a selection by typing <Alt> and the underlined letter. For example, in Windows XP if you press the <Alt> key then press the <F> key, the menu bar shows underlined letters as well as the drop-down menu. You can also click with your left-mouse button on the menu bar headings to see a submenu of options. 

(
Minimize [image: image7.bmp], Double Window [image: image8.bmp], or Maximize [image: image9.bmp], and Close or Exit [image: image10.bmp] buttons:  Clicking once on Minimize [image: image11.bmp] reduces the window to a button on the taskbar XE "taskbar" .  In Windows, the [image: image12.png]44 start ]



 button and taskbar are located at the bottom of your screen. Clicking once on Double Window [image: image13.bmp] returns the window to its previous size. This button appears when you maximize the window. After clicking on the Double Window [image: image14.bmp] button, the symbol changes to the Maximize [image: image15.bmp] button. Click once on the Maximize [image: image16.bmp] button to enlarge the window.  Click once on the Exit or Close [image: image17.bmp] button to close the window, or exit the program.

(
Navigation Aid
:  Peachtree offers a graphical alternative to the menu bar.  The major functions of the program are represented as icons or pictures that show you how tasks flow through the system.  You can click on an icon and perform that function.

(
Toolbar XE "Status Bar" : The gray bar
 at the bottom of the window shows help information about the current field, today’s date or system date, and the current accounting period. The toolbar also includes icons viewing action items; a calculator; and other icons for quick access to Peachtree’s features. Move your mouse over the icons to see what they do. You can hide the toolbar by unchecking the View Custom Toolbar option on the Options XE "Options pull-down"  menu.
TYPICAL WINDOWS USED IN PCA

When you make a menu bar selection, a window displays. You can enter information into that window by using your mouse to click on icons or by typing on your keyboard.
The window illustration below is the Maintain Customers/Prospects window, one that is typical of PCA.  There are four sections on this window:  ( the icon bar, ( the lookup field (magnifying-glass icon), 
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( Previous record or Next record, ( tabs, and ( the drop-down lists (down arrow). 
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(
Icon bar XE "Icon bar" 
: The icon bar shows pictures of commands or additional   information that pertains to the window.  Some icons are common to all windows while other icons are specific to a particular window.  The icons included in the Maintain Customers/Prospects window are:
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Close:  This closes the window without saving any work that has been typed since the last time you saved.
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Save:  This saves information you have entered such as addresses, telephone numbers, contacts for vendors, customers, employees, etc.
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Delete:  If you select this while using a selection from the Maintain menu, the record (customer, vendor, etc.) will be deleted.  When you're finished deleting, select Close, in order to delete the records.
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Change ID: When a customer record is displayed on the window, you may change the information for that customer.
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New: If you select this while using a selection from the Maintain menu, this will clear the record that is displayed and allow you to enter a new one.  This can be used with the following Maintain  

 XE "Maintain pull-down" menu items:  Customers/Prospects, Vendors, Employees/Sales Reps, Chart of Accounts, Inventory Items, and Jobs.

[image: image18.png]


   Event: Select this button in various maintenance windows to create an event. The Create Event window allows you to schedule an event for a customer/prospect, vendor, or employee/sales representative. You can slo use the Event log to record notes about telephone calls, meetings, letters, etc. You use this to create a listing of future activity as well. 
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Log:  This shows you events recorded for an individual over a range of time that you specify.  You can filter this list to see only certain types of activities and whether they're completed or not.  You can mark activities as completed by placing a mark in the far left column.  Double-clicking on any of the line items XE "line items"  will take you to the Create an Event window.  Line items appear on many of Peachtree's windows.  On color monitors, a magenta line is placed around the row (line item) you select.
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 Letters. Select this button to process a mail merge for the currently opened record.
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 Help:  This icon is displayed on most windows.  Selecting this icon gives you information specific to the current window.  The fields of the window are often listed at the bottom of the help message.  When you have a question about how to use Peachtree, clicking on the Help icon often answers it.

(
Lookup Field XE "Lookup Box" :  The most common field you will use in is the lookup field.  When you are in the text portion of the lookup field, the cursor changes to an I-bar with a plus sign and question mark <I +?>.  (For example, when you move the cursor to the Vendor ID field on the Tasks/Payments window, the <I +?> appears.)  In a lookup field, you can either select from a list of records, such as vendors, customers, accounts, etc. or you can type a new record.  You use one of the methods shown below to display a list or type a new record:

	To display a list
	To enter a new record

	In the lookup field, click on the magnifying-glass icon.
	In the lookup field, type a <+>.

	In the lookup field, type a <?>.
	Double-click in the lookup field.

	In the lookup field, click the right mouse button.
	Click on the magnifying-glass icon, and then select New.


(
[image: image21.jpg]


Previous or Next Record. Click on either the left arrow for the previous record; or the right arrow for the next record.
(
Tabs XE "Folder Tabs" :  The tabs that are shown in the Maintain Customers/Prospects window are General, Sales Defaults, Terms and Credit, Payment Defaults, Custom Fields, and History.  Once a customer is selected, you can select one of these folders to display information about a customer.

(
Drop-Down List XE "Drop-Down List" :  The down arrow means that this field contains a list of information from which you can make a selection.  Many of PCA's windows have drop-down lists that appear when you click on a down arrow next to a field.  You can press <Enter> or click on an item to select it from the list.

THE SAMPLE COMPANY:  BELLWETHER GARDEN SUPPLY XE "THE SAMPLE COMPANY:  BELLWETHER GARDEN SUPPLY" 
Bellwether Garden Supply is one of the sample companies included with PCA.  You get a sampling of features that are developed in greater detail as you complete this book.  The purpose of using the sample company is to help you become familiar with the software.
GETTING STARTED XE "GETTING STARTED" 
Follow these steps to start Peachtree Complete Accounting 2005 (PCA):

1.
Start PCA.  If Peachtree Complete Accounting 2005 is not installed on your computer, refer to Appendix A for installing the Peachtree Complete Accounting CD that is included with this textbook. 

2.
When Peachtree Complete Accounting 2005 (PCA) was installed, an icon was created for Peachtree.  Place the mouse pointer on the Peachtree icon and double-click with the left mouse button to start PCA.   (Or, click on Start, All Programs, Peachtree Complete Accounting Educational Version 2005.  Then, select Peachtree Complete Accounting Educational Version 2005.) The startup window is shown below.
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3.
The Peachtree Accounting window appears.  From the startup window, you can Open an existing company; Create a new company; Explore a sample company; Take a guided tour of Peachtree; Convert from a QuickBooks® company or One-Write®  Plus Company; or Exit Peachtree.
4.
Click on Explore a sample company (or hold down the <Alt> key and press <E>).  
5. The Explore a Sample Company window appears.
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6. PCA 2005, has two sample companies:  Bellwether Garden Supply and Stone Arbor Landscaping.  In Chapters 1 – 7, you will use Bellwether Garden Supply to explore Peachtree.  Then, in Chapter 8, you will use Stone Arbor Landscaping to see how Peachtree’s time and billing feature works.  Make sure that Bellwether Garden Supply is selected.  Click [image: image22.png]


.
7. The Peachtree Today - Welcome window appears.  Read the information on this window, then click [image: image23.bmp] on the [image: image99.jpg]=



Peachtree Today title bar to close this window.

[image: image100.jpg]



DISPLAYING PRODUCT INFORMATION XE "DISPLAYING PRODUCT INFORMATION" 
1.
After closing the Peachtree Today window, the menu bar for Bellwether Garden Supply appears.  From the menu bar, click on Help, then About Peachtree Accounting.
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This window shows the copyright information and the Release, Build,  Serial Number, Installed Tax Service, and Registered Tax Service. The Release of the educational version is Peachtree Complete® Accounting 2005; the Build No. is 12.0.00.023E, and the Serial Number is Educational Version. If you are using the commercial version of Peachtree, your Release, Build, and Serial Number will differ. The Installed Tax Service and Registered Tax Service could also differ.
To see if software or text updates have been made, periodically check the Textbook Updates link on the book's website at www.mhhe.com/yacht2005.
2. Click [image: image24.png]


 to close the Product Information window. You are returned to the menu bar. 
BACKING UP BELLWETHER GARDEN SUPPLY XE "BACKING UP BELLWETHER GARDEN SUPPLY" 
Before you begin to make changes to Bellwether Garden Supply, you should back up the sample company data.  When using PCA, information is automatically saved to the hard drive of the computer. In a classroom setting, a number of students may be using the same computer. This means that when you return to the computer lab or classroom, your data will be gone.  Backing up your data simply means saving it to a hard drive, network drive, or external media. Backing up insures that you can start where you left off the last time you used Peachtree.
	Comment
The author suggests backing up the sample company. Since the back up requires 2.24 MB, you will need to back up to the hard drive, network drive, Zip disk, CD (CD-RW drive), DVD (DVD-RW drive) or USB drive. In the textbook, backing up to a drive other than the hard drive or network drive is called backing up to external media. The instructions that follow assume you are backing up to the hard drive of your computer. 
When you back up, you are saving to the current point in Peachtree.  Each time you make a backup, you should type a different backup name (file name) to distinguish between them.  In this way, if you need to restore an earlier backup, you have the data for that purpose.

In the business world, backups are unique to each business: daily, weekly, monthly.  Think of your backups this way and you will see why individual backups at different points in the data are necessary. You should never leave the computer lab without first backing up your data.


Follow these steps to back up Bellwether Garden Supply:

1. The text directions assume that you are backing up to a hard drive location. You can also back up to a network drive location or some other specified location. If you have a CD-RW disk drive, DVD-RW disk drive, Zip disk drive, or USB drive, you can back up to external media. One CD-R, DVD-R, or Zip disk can be used for all backups in the textbook (Chapters 1 through 18). The chart on page 2 (Part 1 opener) shows the size of each backup file in Chapters 1-8 (Part 1 of the textbook).
2.
From the menu bar, click on File, then select Back Up. The Back Up Company window appears.  If necessary, uncheck the box next to Include company name in the backup file name. 
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3.  Click [image: image25.png]Back Up.



.

4. 
The Save in field shows the default location for your backup. If you do not change the Save in location, you will be saving to the hard drive. Click on the down-arrow in the Save in field. The list that displays shows you the location on your hard drive for the sample company files. 
[image: image103.jpg]



5.
Since you are backing up to the default hard drive location, follow these steps.
  Observe that the Save in field shows BCS (or the appropriate drive letter) and that the File name field shows the default XE "default"  name. In the File name field, highlight the default XE "default"  file name and then type bgs as the file name.
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Observe that the Save as type field shows that you are making a Peachtree Backup (*.ptb), which is abbreviated ptb.  This is the standard default XE "default"  for Peachtree backups.

	Comment
If your Save as type field does not show Peachtree Backup (*.ptb), follow these steps:
1. Click on the [image: image26.png]44 start ]



 button, then All Programs. Select Accessories, then Windows Explorer. (These instructions are for Windows XP.)
2. From the menu bar, click on Tools, Folder Options.
3. Click on the View tab. Make sure the box next to Hide extensions for known file types is unchecked.
4. Click [image: image27.png]


. Your PCA files will now have file extensions.
5. Click on File, Close to close your Windows Explorer window. 


6.
Click [image: image28.jpg]


.
7.
A window pops up that says This company backup will require approximately 2.24 MB.
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8. Click [image: image29.png]


. When the Back Up Company scale is 100% completed, you have successfully backed up the sample company.  This takes a few moments. You are returned to Bellwether's menu bar.

Follow these steps to see the size of the backup file.

1. Click on the [image: image30.png]44 start ]



 button.  Then select All Programs.  From the drop-down list, select Accessories, then Windows Explorer. (Hint: These instructions are for Windows XP; they may differ for other Windows versions.)
2. In the Address field, click on the down-arrow, then select drive C (or the location where you backed up Bellwether Garden Supply). For example, if you backed up to the default location, select C:\Program Files\Peachtree\Company\BCS\bgs.ptb.
The Name of the file is bgs.ptb; the Size of the file is 2.42 MB;
 and file Type is PTB File. Compare this information to the bcs folder on your hard drive, network drive, Zip disk, or CD. 

Refer to the chart on page 2 for back up and megabyte information. Peachtree backs up to the current point in the data. Since Bellwether’s data is too large to fit on one floppy disk, the author suggests backing up to a hard drive location or external media (CD-R; DVD-R; USB, or Zip disk.) If you want to back up to a floppy disk, you will need two blank, formatted disks to make the backup: floppy disks hold 1.44 MB of data; the Bellwether backup is 2.42 MB.
Follow these steps to exit Peachtree:

1. 
Close any opened windows. From Windows Explorer, click File; Close.
2. 
From Peachtree’s menu bar, click File; Exit. You are returned to your Windows desktop XE "desktop" .

USING WINDOWS EXPLORER XE "USING WINDOWS EXPLORER" 
The instructions on pages 15–18 show you how to use Peachtree’s Back Up feature. Peachtree’s Back Up feature works with their Restore feature, which is shown on pages 22–26. What if your instructor prefers that all of the company files be copied or saved? 
1. 
The Windows desktop XE "desktop"  should be displayed. 

2. 
If your desktop XE "desktop"  has a Windows Explorer icon double-click on it. Or, click on the [image: image31.png]44 start ]



  button; select All Programs, then Accessories; then Windows Explorer. 
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In the Address field, select drive C. Then, open the folder for Bellwether Garden Supply: C:\Program Files\Peachtree\Company\BCS (this is the default location for Peachtree; your location may differ). 

4. 
Right-click on the BCS folder.  A drop-down menu appears.  Left-click on Properties.

[image: image107.jpg]Changeld




5. 
Observe that the size of the BCS folder is 14.5 MB (or 15,249,531 bytes). The size of your BCS folder may differ; this is OK. If you want to copy the entire folder to a disk, you will need to have a Zip drive or CD-RW drive. The steps shown for Copying the Bcs folder to a Zip Drive or CD-RW Drive (on pages 21-22) explain how to do that. Peachtree folders need read and write access in order to be used.  USB drives, Zip disk drives and CD-RW disk drives are read/write.

6. 
Click [image: image32.png]


 to close the BCS Properties window. Click [image: image33.bmp] on the C:\Program Files\Peachtree\Company title bar to close Windows Explorer.
Copying the Bcs Folder to a Zip Drive or CD-RW Drive 
Follow these steps to copy the BCS folder to a Zip disk or to a CD-RW drive. If the Zip drive or CD-RW drive is located in a different location, substitute that drive letter. Depending on the software you are using to copy data to a CD, your instructions may differ.
1. If necessary, click on File, Exit to exit Peachtree and return to your desktop. Put the CD-R disk in your CD-RW drive (or other external media in the appropriate drive). In this example, drive F is to identify the CD-RW drive. (Substitute the correct drive letter for your computer.) 

If you are copying files to a CD, a window may pop-up that asks What do you want Windows to do? In this example, the Open writable CD folder using Windows Explorer was selected.
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Locate the BCS folder on your hard drive. The default XE "default"  location is C:\Program Files\Peachtree\Company\BCS.  Click on BCS to select it. On the left side of the screen, there is a File and Folder Tasks list. Click on Copy this folder.  
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3. When the Copy Items window pops up, select the appropriate Zip drive or CD-RW drive to copy to. In this example CD Drive (F:) is shown. Select the correct drive on your computer for the external media that you are using. 
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Click on [image: image34.png]


.  A window pops up showing the files are being copied.  If you are copying the files to a CD, make the selections to write the files to your CD.
5. To check that the file was copied, make sure your CD disk or other external media is in the drive, then go to the appropriate drive right-click on the BCS folder and select Properties. The BCS Properties window should look similar to the one shown on page 20.

6. Click [image: image35.bmp] on the title bar to close the windows.


When you copy the BCS folder from drive C to a CD-RW drive or other external media, you are copying all the files contained in the folder. Remember, backing up files compresses the data (or makes the file smaller). Copying the entire folder allows you to have all the BCS files on external media.  When you want to return to where you left off, you can use Windows Explorer to copy and paste these files from your CD (or other external media) to Peachtree’s program path and Bellwether’s folder on drive C– C:\Program Files\Peachtree\Company\BCS.  
Remember, the instructions in the textbook teach you how to use Peachtree’s Back Up and Restore features.  Check with your instructor for his or her preference.

USING PEACHTREE’S RESTORE WIZARD XE "RESTORING COMPANY DATA FROM A FLOPPY DISK" 
In order to start where you left off the last time you backed up, you use Restore. Your school may prefer that you use Windows Explorer to copy/ paste instead of Peachtree’s Restore feature. You may need to check with your instructor on the preferred method. This book uses Peachtree’s Restore feature.

Follow these steps to use Peachtree’s Restore feature.
1.
Start Peachtree in the usual way. 

2.
On the startup window, click on Explore a sample company.  Make sure Bellwether Garden Supply is selected. Click [image: image36.png]


.

3.
To restore Bellwether’s files, do the following:


a.
If necessary put your CD-R, DVD-R or other external media in the appropriate drive. The steps that follow assume that you are restoring from Peachtree’s default hard drive location.
b.
From the menu bar, click on File, then Restore. The Restore Wizard – Select Backup File window appears. The window below shows Peachtree’s default location for backing up.
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	Steps for Restoring from External Media
1. In the Location field, click [image: image38.png]Browse.



. 
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In the Look in field, select the appropriate drive. The illustration  shows drive E. Highlight the bgs.ptb file.

3. Click [image: image39.png]


.

4. Observe that the location field shows the drive location and the name of the file (bgs.ptb). Continue with step c. on the next page. Remember, the textbook steps assume you are restoring from a hard drive location.


c. Click [image: image40.jpg]


. The Select Company window appears. Observe that An Existing Company is the default. The Company Name field shows Bellwether Garden Supply and the Location shows Bellwether’s location.  


	
Read Me

Observe that there are two options on the Select Company window: An Existing Company (which is the default) and A New Company. If you select A New Company, then the company will be named exactly as the backup file you selected. Here is how that works. 

1. Click on the radio button next to A New Company.

2. Look at the Location field. The subdirectory for Bellwether has changed to \belgarsu. (When you accepted the default for An Existing Company the subdirectory showed \BCS.) 

This is an important distinction. You can restore to an existing company—one that is previously set up—or you can restore to a new company, bypassing the process of setting up a new company. (Setting up a new company is shown in Chapter 9.) Let’s say you wanted to restore a backup file for a company that was not set up in Peachtree. 

Some schools delete subdirectories from the hard drive; for example, you have a back up file but the company, in this case Bellwether Garden Supply, is not listed as a Peachtree company. If you start Peachtree and you cannot select Bellwether, use the Restore Wizard to select A New Company. Using your backup file, and the selection for A New Company, you are able to get started where you left off the last time you used Peachtree.
Remember to select An Existing Company before continuing with step d



d. Read the information on the window, then click [image: image41.jpg]


. The Restore Options window appears. Make sure that the check mark is next to Company Data.  

e. Click [image: image42.jpg]


. The Confirmation window appears. Remember, the textbook steps assume you are restoring from Peachtree default hard drive location (C:\Program Files\Peachtree\company\BCS\bgs.ptb). If you are restoring from external media, the From field will show the appropriate drive letter.

f. Read the information on the Confirmation window, then click [image: image43.jpg]


. Your backup data starts to restore. When the scale is 100% complete, the Bellwether Garden Supply data is restored. On Peachtree Today’s title bar, click [image: image44.bmp] to close the Peachtree Today window.
Now that you have restored Bellwether’s files, you are ready to continue using the sample company.  Remember before you exit PCA, make a backup of your work.  
USING PEACHTREE TODAY XE "USING PEACHTREE TODAY" 
The instructions that follow assume PCA was just installed and is being used for the first time.  If PCA has been used before, your Peachtree Today window may look different. 

At the bottom of the screen on the toolbar, there is a [image: image45.jpg]i Today]



 icon. If necessary, click on the [image: image46.jpg]i Today]



  icon and the Peachtree Today window pops up. If the Peachtree Today window is already displayed, continue with the next section.

Your Peachtree Today window may differ.  This is okay.  Read the information to become familiar with what it says.  You may want to explore some of the links.  The underlined words are links to other information.

Follow these steps to try one of the links.

1. Move your cursor over My Business. Observe that your cursor changes to a hand. (If you do not have a My Business link, go to step 2.)

2. Click once on the My Business link. (If PCA has been used before, click on the My Business radio button on the left side of Peachtree Today's window).  
3. If necessary, scroll down to see more. You can also explore additional links by clicking on another tab.
4. When you are through, click [image: image47.bmp] on the Peachtree Today - My Business Sales & Receipts title bar.  
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5. You are returned to Bellwether Garden Supply's menu bar.
To hide the Peachtree Today window at startup, follow these steps.

1. On the toolbar, click on the [image: image49.jpg]i Today]



 icon.  The Peachtree Today – Welcome  window appears.

2. Click on the [image: image50.jpg]iy Preferpnces
G Pascres Tk



 link.

3. If necessary, scroll down to go to the Start Up area. Observe that there is a check mark next to Display Peachtree Today each time this company is opened. Click on the box to uncheck it.
4. Click on the [image: image51.bmp] on the Peachtree Today – Preferences General title bar.

To check that Peachtree Today no longer displays at startup, follow these steps.
1. From Bellwether’s menu bar, click on File, Exit.  You are returned to your Windows desktop.

2. Restart Peachtree. At the startup menu, select Explore a sample company. Make sure that the radio button for Bellwether Garden Supply is selected, then click on [image: image52.png]


.
3. When Bellwether starts, the Peachtree Today window is not displayed. If Peachtree Today is displayed, complete the steps that follow. 
a.
Link to Preferences.
b.
Scroll down the window to the Start Up section.
c.
Make sure the box is unchecked next to Display Peachtree Today each time this company is opened.  Close the Peachtree Today window.
MENU BAR XE "MENU BAR"  
PCA's menu bar has ten selections: File, Edit, Maintain, Tasks, Analysis, Options, Reports, Services (this selection is active on the commercial version and inactive on the educational version), Window, and Help.  

Follow these steps to explore the menu bar.

1.
From the menu bar, click on File to see its menu, or, press <Alt> + F to display the File menu. XE "File pull-down menu"   If you use <Alt> + F instead of your mouse, notice that the individual letters on the menu bar are underlined. In this example, the mouse was used.


In order to show these File menu XE "File pull-down menu"  selections, the General Ledger Trial Balance was displayed from the Reports menu XE "Reports pull-down menu" .

The File menu XE "File pull-down menu"  allows you to open an existing company, open the previous company, create a new company, open the start screen, print, print preview, setup the page, back up and restore data, make an online backup (if you subscribe to this service), import files into PCA from other programs, export files from PCA to other programs, verify data, load and edit payroll tax tables, and exit.  

Menu choices that are followed by an ellipsis are associated with dialog boxes XE "dialog boxes"  or windows that supply information about the window you are using.  An arrow (►) next to a menu item (Payroll Tax Tables) indicates that there is another menu with additional selections. 


To cancel the drop-down menu, click on File or <Esc>.

2. Click on Edit to see its menu.


In order to show these Edit selections, the Maintain Customers/ Prospects window was opened.  Then, one of the customer records was selected. The grayed-out selections are inactive.
The Edit menu XE "Edit pull-down menu"  allows you to cut, copy, paste, and clear objects from one place to another via the Windows feature called the clipboard.  Change ID allows you to change information in maintenance windows; for example, you can change the account number of a general ledger account. You can also spell check and find transactions. You can Send E-mail and view web pages. You can also filter records, locate fields, change fonts, and show headers.  Delete Record allows you to delete maintenance records.

3.
Click on Maintain to see its menu.



The Maintain XE "Maintain pull-down"  menu allows you to enter, view, or edit required information for your company's customers or prospects, vendors, employees or sales reps, chart of accounts, inventory items,  item prices, and job costs. You can also edit company information; enter memorized transactions; or go to default XE "default"  information, sales tax codes, and passwords.  Defaults are commands that PCA automatically selects.  Default information automatically displays in windows.  You can change the default by choosing another command. 

4.  Click on Tasks to see its menu.


The Tasks  XE "Tasks pull-down"  menu allows you to enter quotes and sales orders, sales invoices, receipts, finance charges, select for deposit, issue credit memos, purchase orders, purchases for inventory, select bills to pay, make payments, write checks, issue vendor credit memos, display account registers, record time and expenses, record payroll information, and make general journal entries. You can also make inventory adjustments, assemblies, reconcile bank statements, void checks, and enter action items.  With the System selection, another menu displays with choices such as post and unpost (available with batch posting), change the accounting period, use the year-end wizard, and purge old or inactive transactions.

5.
Click on Analysis to see its menu.


The Analysis XE "Analysis pull-down"  menu allows you to view customized graphics developed for specific companies.  You can use the cash manager, collection manager, payment manager and financial manager.

6.
Click on Options to see its menu.


The Options XE "Options pull-down"  menu allows you to set global options XE "global options"  for a company, change the system date, define your Internet XE "Internet"  connection, and customize the toolbar.  Global options are settings that affect the entire program. When you set global options for one company, you set them for all companies.  

The check marks next to View Custom Toolbar XE "Status Bar" , View Navigation Aid, and Show Start Screen at Startup sets these Peachtree options.  If they are unchecked these options will not display.

7. Click on Reports to see its menu.



The Reports menu XE "Reports pull-down menu"  allows you to queue XE "queue"  reports for printing or display reports.  You can also create and edit the format for reports, forms, and financial statements.  The My Business selection takes you to Peachtree Today – My Business Sales & Receipts window. This window was shown on page 27. You can also print or display daily registers. 
8.
The Services menu is inactive in the educational version of PCA. On the commercial version of Peachtree Complete 2005, the Services menu has selections for Peachtree Today, Check for Updates, Credit Card Authorization, Internet XE "Internet"  Postage, My Web Site, Peachtree Web Services, and the Peachtree Web Transaction Center. 

9.
Click on Window to see its menu.  (Hint: To see these choices, click on [image: image53.jpg]i Today]



 on the toolbar. The Maintain/Customers Prospects and general ledger report windows were closed.)


The Window XE "Window pull-down"  menu allows you to arrange how the windows and icons are displayed and close all open windows.  Cascade allows you to display document windows in overlapping format. Tile allows you to display windows side by side, with no window overlapping any other window.  You can also select Arrange Icons to change the look of your desktop XE "desktop" . Close All allows you to close all the windows at once.  According to the list shown on the Window menu, there is one window open: 1 Peachtree Today - Welcome.

10.

Click on Help to see its menu.


The Help menu XE "Help pull-down menu"  allows you to open a window of context-sensitive help, run tutorials for PCA and Windows, and display file statistics (part of the Customer Support and Services selection).  Select About Peachtree Complete Accounting to display product information.  How to display product information was shown on pages 13-14.

BECOMING AN EMPLOYEE OF BELLWETHER GARDEN SUPPLY XE "BECOMING AN EMPLOYEE OF BELLWETHER GARDEN SUPPLY" 
Before you add yourself as an employee of Bellwether Garden Supply, let's learn how to use the Navigation Aid to open the Maintain Employees window.  The Navigation Aids XE "Navigation Aids"  are listed across the bottom of your screen. They are:  Sales, Purchases, Payroll, General Ledger, Inventory, Time & Billing, Analysis, and Company. (Hint: If the Navigation Aids are not shown on the bottom of the screen, click Options from the menu bar. Click on View Navigation Aid to place a check mark next to it.) 
Follow these steps to use the Navigation Aid to add yourself as an employee. Close the Peachtree Today window before you begin. 

1.
At the bottom of your screen, click on the Payroll Navigation Aid [image: image54.png]o Payrol



. The Peachtree Today ‑ Navigation Aids Payroll window pops up.

The Payroll Navigation Aid flow chart shows what happens when a Payroll Entry is made. Observe the links on the flow chart. These selections can also be made from the Maintain, Tasks, and Reports  menus. The Payroll Navigation Aid organizes information into three sections.

a.
Maintenance selections include links to Employees, Edit Company Tax Tables, and the Payroll Setup Wizard. 
b.
Task selections include links to Select for Payroll Entry, Payroll Entry, Print Payroll Checks, and Void Checks.
c.
Report selections include links to All Payroll Reports, Payroll Journal, and General Ledger. 
2.
Click [image: image55.jpg]


. The Maintain Employees/Sales Reps window appears.
( 
The icon bar at the top of most windows shows graphical representations of commands or functions that are accessible from the window.
(Lookup fields have a text area and a magnifying-glass icon.   When you are in the text portion of the lookup field, the cursor changes to an I-bar and a question mark  < I ? >.  Click the left mouse button on the magnifying-glass icon, or type a question mark <?> in the lookup field, or click the right mouse button to display lists.

( 
Radio Button or Option Button XE "Option or Radio Buttons" :  These buttons allow you to select one by clicking with the mouse or using the space bar.  The default XE "default"  is Employee shown by the radio button next to Employee.

(
Tabs are common to most PCA windows. They provide a subtitle to the various windows that store and organize information. Here, for example, the information you can choose to track is subdivided into six categories:  General, Custom Fields, Pay Info, Withholding Info, EmployEE Fields, and EmployER Fields.

(
Text fields are rectangles or fields where information is typed.

(
Date fields; Calendar icons: You can type dates in the date field or click on the calendar icon. The date is selected by clicking within the calendar icon.

Adding Yourself as an Employee XE "Adding Yourself as an Employee" 
Follow these steps to add yourself as an employee.

1.
Type an Employee ID code for yourself in the Employee ID field.  For example, type CYACHT (type the first initial of your first name and your full last name in all capital letters); use all capital letters and press <Enter>.

2.
In the Name field, type your first name, press <Enter>; type your middle initial, if any, press <Enter>, then type your last name.  Press <Enter> two times.
 

3.
In the Address field, type your street address.  There are two lines so you can enter an ATTENTION line or P.O. Box, if necessary.  If you are using just one line for your address, press <Enter> two times to go to the City, ST Zip fields.

4.
In the City, ST Zip field, type your city, state (two-digits), and zip code, pressing <Enter> after each.

5.
None of the other information is required.  You will work with the other fields in the Payroll chapter.  Click on the [image: image56.jpg]fit=
18



 icon or press the function key <F5> to save your entries.

To check that your Employee ID has been added, click on the magnifying glass next to the Employee ID field.

6.
Select Close or <Esc> to return to the menu bar. Close the Payroll Navigation window.
BACKING UP CHAPTER 1 DATA XE "BACKING UP CHAPTER 1 DATA" 
Follow these steps to back up Chapter 1 data:

1. From the menu bar, select File, then Back up. Make sure that the box next to Include company name in the backup file name is unchecked.
2. Click [image: image57.png]Back Up.



.
3. Save to the default location; or, if you are backing up to a network drive or external media, make the appropriate selection in the Save in field.
4. Type Chapter 1 in the File name field.
5. Click on the [image: image58.jpg]


  button.  
6. When the window prompts that This company backup will require approximately 2.24 MB, click on [image: image59.png]


. When the Back Up Company scale is 100% complete, you have successfully backed up to the current point in Chapter 1.  You are returned to the menu bar.
7. Click on File, Exit to exit Peachtree.

MANUAL VS. COMPUTERIZED ACCOUNTING XE "MANUAL VS. COMPUTERIZED ACCOUNTING" 
Because there are differences between manual and computerized accounting systems, you will notice in several instances that the procedures used in PCA are slightly different than those outlined in the steps of the manual accounting cycle.  

The differences between the Manual and Computer Accounting Cycle are shown on the next page. The first step of the Computer Accounting Cycle is New Company Set Up, which includes the option for selecting a Chart of Accounts. The Manual Accounting Cycle does not include a New Company Set Up. In manual accounting, the chart of accounts is the same as the accounts in the general ledger.

Step five of the manual cycle shows a worksheet. There is no worksheet in the computerized cycle.  

In PCA you can complete account reconciliation. Account reconciliation automates bank reconciliation.  

Another important difference is that in the Computer Accounting Cycle, the adjusting entries are journalized and posted before printing the financial statements.  

In the computerized cycle, Step 10, change accounting periods, is similar to closing the month manually except that the temporary accounts maintain balances so a post-closing trial balance is not available.  PCA 
tracks income and expense data for an entire year.  At the end of the year, all revenue and expense accounts are closed to equity.  

	MANUAL ACCOUNTING CYCLE
	PCA’s COMPUTER ACCOUNTING CYCLE

	1. 
Analyze transactions


	 1.
New Company Set up.  (You have the option of selecting a chart of accounts.)

	2.
Journalize entries.
	 2.
Analyze transactions.

	3. 
Post to the ledger.
	 3.
Journalize entries.

	4. 
Prepare unadjusted trial balance.
	 4.
Post to the ledger.

	5. 
Prepare worksheet.
	 5.
Print general ledger trial balance (unadjusted).

	6.
Prepare financial statements: income statement, statement of changes in owner's equity, and balance sheet.
	 6.
Account reconciliation: reconciling the bank statement.

	7.
Adjust the ledger accounts: journalize and post adjusting entries.
	7.
Journalize and post adjusting entries.

	8.
Close the temporary accounts:  journalize and post the closing entries.
	 8.
Print the general ledger trial balance (adjusted).

	9.
Prepare post-closing trial balance.
	 9.
Print financial statements:  balance sheet, income statement, statement of cash flow, and statement of changes in financial position.

	10.
Reverse entries (optional).
	10.
Change accounting periods.

	11.  Interpret accounting information


	INTERNET ACTIVITY XE "INTERNET ACTIVITY" 

	The Internet XE "Internet"  is a worldwide electronic communication network that allows for the sharing of information. The World Wide Web XE "World Wide Web"  (WWW) or Web is a way of accessing information over the Internet. To read about the differences between the Internet and the Web, go to www.webopedia.com/DidYouKnow/Internet/2002/Web_vs_Internet.asp.
To make an Internet connection, your computer must be equipped with a modem XE "modem" . The word modem is an abbreviation of Modulator/Demodulator. A modem is a device that translates the digital signals from your computer into analog signals that can travel over telephone lines. There are also DSL (digital subscriber lines), wireless, and cable modems, as well as T-1 lines for faster connections.

	1.
	Start PCA. Open Bellwether Garden Supply. If necessary, connect to your Internet browser.

	2.
	From Bellwether’s menu bar, select Help; Peachtree on the Web, Peachtree Software Home Page. (Hint: You must be connected to the Internet. XE "Internet"  If a window pops up that asks if you want to make an Internet connection, follow the prompts to make a connection. A window may pop up that says you are about to enter a server-provided Internet Resource. Click on OK to continue.)

	3.
	Websites are time and date sensitive. When using the Internet XE "Internet" , be aware that changes will likely take place.  For purposes of this assignment, you will link to Peachtree’s press releases. When you place your cursor over Press, the cursor changes to a hand symbol ([image: image60.png]o PrESS



). Click Press and the Best Software Small Business website appears. Observe that there is a Peachtree News column. The website address is http://smallbusiness.bestsoftware.com/press/. 

	5.
	Select two links from the Peachtree news column. Using a word processing program, write an essay about each site you selected. Remember to include the website address of each link. Your summary for each site selected should be no more than 100 words or less than 75 words.

	6.
	From your Internet XE "Internet"  browser, go to the textbook’s website at www.mhhe.com/yacht2005. Link to the Student Edition.

	7.
	Link to Internet XE "Internet"  Activities, then Web Exercises Part 1. You may open or save these web exercises. Complete the Web Exercises for Chap. 1.

	8.
	Complete the first activity, ACCOUNTING MONOPOLY – Chapter 1. This is a group activity. Check with your instructor regarding this assignment.


SUMMARY AND REVIEW

SOFTWARE OBJECTIVES:  In Chapter 1, you used the software to:

1.
Start Peachtree Complete Accounting 2005 (PCA).

2.
Explore the sample company, Bellwether Garden Supply.

3.
Back up Bellwether Garden Supply data.

4.
Restore data with Peachtree’s restore Wizard.

5.
Operate Peachtree’s menus, drop-down lists, lookup fields, toolbar, and navigation aid.

6.
Navigate Windows Explorer.

7.
Explore Peachtree Today to link to the Internet and learn about software features.

8.
Make three backups: 1) Back up starting data for Bellwether Garden Supply; 2) back up Chapter 1 data; and 3) back up Exercise 


1-2
WEB OBJECTIVES:  In Chapter 1, you did these Internet XE "Internet"  activities:

1. Used PCA to link to Peachtree’s website at www.peachtree.com.
2. Linked to Peachtree Software’s Press page.

3. Selected two Peachtree News articles and wrote an essay about each one. 

4. Used your Internet XE "Internet"  browser to go to the book’s website at www.mhhe.com/yacht2005.

5. Complete the first web exercise in Part 1.

GOING TO THE NET

	Comment
The textbook website at www.mhhe.com/yacht2005 has a link to Textbook Updates. Check this link for updated Going to the Net exercises.


 XE "GOING TO THE NET" 
Access the Career Development website at

www.net-temps.com/careerdev/index.htm?type=careertalk&channel=fin&topic=careers
Read the article Careers in Accounting & Finance.
1. What three skills are essential for those seeking careers in accounting and finance?

2. What is the preferred educational background for an accountant?

3. List five career opportunities in accounting and finance.

True/Make True:  Write the word True in the space provided if the statement is true.  If the statement is not true, write the correct answer.

1.
Peachtree’s graphical user interface is similar to other programs that use the Windows operating system.



_______________________________________________________


_______________________________________________________

2.
If there is an underlined letter in the menu or option you want to select, hold down the <Alt> key and the underlined letter to make the selection.


_______________________________________________________


_______________________________________________________

3.
 XE "Shortcut keys"  Shortcut keys enable you to use Peachtree’s mouse.


_______________________________________________________


_______________________________________________________

4.
In this book, the angle brackets are used to indicate individual keys on the keyboard; for example <Tab>.




_______________________________________________________


_______________________________________________________

5.
You can close the application you are working with if you single click with your mouse on the close button ([image: image61.bmp]).


_______________________________________________________


_______________________________________________________

6.
You can hide the toolbar on your screen by unchecking that option on the Options menu.


_______________________________________________________


_______________________________________________________


7.
In PCA, some icons are common to all windows while other icons are specific to a particular window.


_______________________________________________________


_______________________________________________________

8.
The Navigation Aid is shown at the top of your window.


_______________________________________________________


_______________________________________________________


9.
Peachtree’s Restore Wizard allows you to restore existing companies only.

_______________________________________________________


_______________________________________________________

10.
The extension used for Peachtree backups is .XLS.


______________________________________________________


______________________________________________________

Exercise 1-1:  Follow the instructions below to complete Exercise 1-1:

1. Start PCA.  Start the sample company, Bellwether Garden Supply.

2. Follow these steps to restore your data from the end of Chapter 1:

a. From the menu bar, click on File, Restore. (The backup file was made pages 39-40.)
b. The Select Backup File window appears. If the Location field is correct, click [image: image62.jpg]


. 
	
Read Me: 

If your back up file is located on external media, or if the Location field does not show C:\Program Files\Peachtree\company\BCS\Chapter 1.ptb in the Location field, click [image: image63.jpg]


, then follow these steps.

1. The Open Backup File window appears. In the Look in field, select the appropriate location of your backup file.
2.    Highlight the Chapter 1.ptb file.
3.    Click on the [image: image64.png]


, then click [image: image65.jpg]


. Continue with step c below.


c. From the Select Company window make sure that the radio button next to An Existing Company is selected. The Company name field shows Bellwether Garden Supply; the Location field shows C:\ProgramFiles\Peachtree\Company\BCS (or the appropriate location on your computer). Click [image: image66.jpg]


.

d. The Restore Options window appears. Make sure that the box next to Company Data is checked. Click [image: image67.jpg]


.

e. The Confirmation window appears. Check the From and To fields to make sure they are correct. Click [image: image68.jpg]


.  When the Restore Company scale is 100% complete, your data is restored and you are returned to the menu bar.  

f. If necessary, remove the external media. 
3. Continue using PCA and complete Exercise 1-2.

Exercise 1-2:  Follow the instructions below to complete Exercise 1-2:

1.
Add Katherine Lee as a new employee.


Employee ID:
KLEE [use all caps]


Name:


Katherine Lee

Address:

2012 Aspen Circle

City, ST Zip:
Norcross, GA 30093
2. Follow these steps to back up Exercise 1-2:

a. From the menu bar, select File, then Back up.
b. Click [image: image69.png]Back Up.



.
c. Accept the default for backing up to the hard drive or make the selections to back up to another location. Type Exercise 1-2 in the File name field.
d. Click [image: image70.jpg]


.
e. When the window prompts that This company backup will require approximately 2.24MB, click on [image: image71.png]


. When the Back Up Company scale is 100% complete, you have successfully backed up to the current point in Chapter 1.  You are returned to the menu bar.
3. 
Click on File, Exit to exit Peachtree. 
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	�If Peachtree Complete Accounting 2005 is not installed see Appendix A, Installing the Software, pages 661-667. The sample companies must be installed to complete Chapters 1–8.


	


	� Refer to the chart on page 2 for the size of backup files.


	�The angle brackets are used around words to indicate individual keys on your keyboard; for example, <Alt> is for the Alternate key, <Enter> for the Enter/Return key, <Ctrl> is for the Control key, <Esc> is for the Escape key.


	�If the Navigation Aid is not displayed on our screen, from the menu bar� XE "menu bar" �, select Options, click on View Navigation Aid to place a check mark next to it.


	�Screen colors may differ.  Check with your instructor if you have a question.


	�Notice that familiar business items are used for icons:  file folder (Close), disk and Rolodex card (Save), and a trash can (Delete).


	


	�If you are backing up to a network drive, CD-RW, DVD-RW, USB, or Zip drive, substitute the appropriate drive letter. 


	


	�You may notice that the size of your backup file differs. This is okay.


	�All ID codes are case-sensitive� XE "case-sensitive" � which means that cyacht and CYACHT are considered different codes. Capital letters sort before lowercase letters.


	     


	10You can use <Enter> or <Tab> to move from field to field.  Use <Shift>+<Enter> or <Shift>+<Tab> to move back a field.  You can also hold the <Alt> key and press the underlined letter of a text box to move between fields.	


	�If Bellwether Garden Supply is not shown in the Company Name field, select A New Company and restore from the backup file. For more information on restoring A New Company, see the Read Me box on page 24. 
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